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Course Introduction

Welcome to A Practical Introduction to VA’s Linux Desktop. This course is a hands-on introduction.
The way to learn to ride bicycle is to practice. Similarly, the way to learn the Linux desktop is to
use it. Don’t be afraid to experiment with it. Unlike Microsoft Window where experimenting with
the computer may cause serious problems, Linux is robust and protects you from unforeseen disasters
like the blue screen. You’re more likely to hurt yourself learning to ride a bicycle than you are to
hurt yourself, other users, or your system when learning the Linux desktop. If you do damage to your
system, don’t worry. Someone in the Information Systems (IS) department will put your system back
in working order.

Prerequisites

I assume that you’ve had experience using a computer with a mouse and little or no experience with
Unix or Linux. If you have had some experience, you are a step ahead.
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A COURSE OBJECTIVES

A Course Objectives

This course will get you started using the Linux desktop. After completing this course, you will be able

to:

Log on to a Linux system.
Start your desktop (a graphical interface to Linux).
Change your password.

Bring up Netscape.

Access VA Linux’s internal Web site (https://vaweb.valinux.com).

Submit an IS or facilities request.
Read your email using Netscape.
Create an address book.

Sign up for mailing lists.

Set up vacation email auto-responding.
Browse your files and directories.

Start applications from your desktop.
Use a text editor.

Create documents using StarOffice.

Run Windows from your Linux Desktop.

Sync up your Palm Pilot or Handspring Visor on Linux.

Print a document on a specific printer.

Set up a printer as your default.

Work with floppies and CD-ROMS.

Switch between applications.

Kill a running application.

Log out, reboot and shutdown a Linux system.
Login remotely.

Read your email remotely.

B What You Need

Since this is a hands-on course, you will need access to a Linux computer.
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C Course Resources
T’ve provided the following resources to accompany this course.

e A hardcopy of the course notes, which you can find on VAWeb at
https://vaweb.valinux.com/Training/desktop/desktop.pdf
¢ An online version of the course notes
https://vaweb.valinux.com /Training /desktop

e A glossary, which can be found at the end of the course notes.
e List of sites or links with additional related information.
e Fasy Linux by Lisa Lee, a book offering a visual introduction to Linux geared for the novice.

o Learning DEBIAN GNU/LINUX by Bill McCarty. See Chapter 4 Issuing Linuz Commands if
you are interested in learning about the shell or command line interface to Linux.

o Getting Started With Your VA Linuz System (VA Linux Systems, 2000, part number 102439-00.

o Introduction to the Bash Shell or When is it Worth Typing Instead of Clicking?, which is another
course I have developed.

https:/ /vaweb.valinux.com/Training/shell /bash.pdf

Please check out these resources.

D Acknowledgments

First, I offer thanks to Henry Cejtin for encouraging me to use Linux and David desJardins for his
suggestions and support (both for my home computer and me). These notes were initially prepared
for the first Practical Introduction to VA’s Linux Desktop, which I gave on June 12, 2000. They have
been revised for subsequent courses incorporating valuable comments and suggestions from many people
to whom I am grateful. They include: Jonathan Adams, Nelson Blachman, Nolwenn Carcion, Henry
Cejtin, Jay Lemley, Scott McNeil, Denise Mercer, and Carl Strasen.

E About the Instructor

I started using Unix over 20 years ago when I worked at Bell Laboratories. I have been enjoying working
with various versions of Unix ever since, including BSD, HPUX, NextStep, Solaris, SunOS, System 5,
and Ultrix. I started using Linux in 1996.

Before joining VA Linux Systems, where I am the technical training manager, I was president of
Variable Symbols where I taught and wrote books on mathematical software. I also taught in the
Computer Science Department at Stanford University.

F Notation

This section describes the notation I use in this course.

Fixed-width font is used for user input and output to look similar to how they appear on your screen.
e.g.,
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$ whoami
nblachman

Italic is used for several purposes:

e Introducing a term, e.g.,
Enter your command(s) after the shell prompt, which might be $, %, or >.

¢ Designating a type of input, where you should replace it with the actual value. In the
following example, replace username with your username, which is sometimes referred to as
your login name.

Login: username
e Designating menu items and icons, e.g., select Logout from the menu to exit out of your

Linux desktop.

SMALL CAPS FONT for designating special keys.

Notation | What it means

RETURN Hit the return key (also known as carriage return).

ALT-A Depress the alt key and then depress the a key.

CTRL-B Depress the control key, hold it down, and then depress the b
key.

ESC-C Hit the escape key and then hit the letter c.

Table 1: Special keys that can be used on Linux systems.
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1 Getting Started

Now that I've covered the preliminaries for this course, let’s get started using Linux. We’ll begin by
logging on and then you’ll learn how to change your password, start your desktop, handle your email,
get help online, launch applications, access VA’s internal web site, print on one of VA’s printers, issue
commands to the shell (command line), logout, and access your system remotely.

There are two types of interface to Linux:

e A graphical user interface (GUI) with windows, menus, and icons.

e A command line interface, known as a shell! is flexible; you are not limited by menu items that
someone else set up. The shell is extensible; you can add your own commands to the system and
change its appearance. It is faster than most graphical user interfaces. The shell is good for doing
just about anything provided you don’t mind typing commands.

The shell may appear more cumbersome to learn than it is. It is like learning to drive a standard
transmission car; it takes a while to get started, but once you get the hang of it, I wouldn’t be
surprised if you prefer using the shell to using programs with graphical user interfaces.

In this course I present both interfaces but I focus more on the GUI interface because it is easier
to learn. If you want to become more adept with the shell, I suggest that you take Introduction to the
Bash Shell or When is it Worth Typing Instead of Clicking?, which is another course I have developed.

1.1 Logging On

To use Linux, you need a login name and password, which you can obtain from your system adminis-
trator. Enter your username at the login prompt. Note: Linux is case sensitive. An upper-case letter
is interpreted as a different character than a lower-case letter. So nancy, Nancy, and NANCY are not
synonymous. After you enter your username, the system will request your password, which it won’t
display on the screen s you type it

$ login: nblachman
Password:

If this is your first time on the system, you may be asked to select a new password.

Exercise

Log on to your system. Unless you made a special request (and it was accepted), your login name
(username) is the first letter of your first name followed by your last name, e.g., nblachman. If you
don’t know your password, contact IS to get your initial password, which I strongly urge you to change
and TI’ll show you how to do that later in this course.

1.2 Starting up your Desktop

After you log in, the system may either:

e Start up your desktop, in which case your screen should look something like Figure 1.

e Prompt you for input with a $, %, or >. In these notes, I use $ as the command line prompt.

If you see a $, %, or > on your screen, simply type startx followed by the RETURN or ENTER key to
start your Linux desktop.

IWhy the name “shell”? T’ve heard it came from a walnut. As in the center of a walnut is the kernel, in the center
of Linux is the kernel. Outside the walnut is the shell, the part that you handle to get to the nut. Outside the Linux
kernel are utilities known as the shell that allow you to instruct the kernel to perform services for you. The Linux kernel
provides operating system services, such as disk and device access, which allow you to read and write files.
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N I o e

Figure 1: The KDE desktop.

$ startx

On an IS maintain system, this will start up KDE (the K Desktop Environment)?. Your computer
should display a desktop similar to the one shown in Figure 1. The background of your screen might
look different than the one shown in the figure since I customized my desktop.

Exercise

Start up your Linux desktop, if it didn’t startup automatically when you logged in.

1.3 Getting Help

Often Linux provides several ways to do things. Help is no exception. You can get help through the
desktop or by using a shell (command-line interface).

Curious about the KDE desktop? You can read more about it using KDE Help and the KFM
Handbook. 1 hate to admit this, but I haven’t found either of these help tools as useful as the online

manual that is accessible from the shell.

Figure 2: You can access online help via KDE Help.

Here’s how to access help in the the KDE Help utility.

1. Click on the KDE Help icon (Figure 2), which has a key standing on top of a manual or book.

2KDE is the default for VA Linux Systems workstations. It is based on the Common Desktop Environment (CDE)
standard from which Microsoft Windows was also derived. It provides icons, a toolbar, and menus with applications.
Another popular desktop is Gnome. It was developed as a GNU Open Source project.
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2. Then click on whatever topic you want to learn about. Here are the topics that were listed in my
browser:

Welcome to the K Desktop Environment

What is the K Desktop Environment?
Contacting the KDE Project
Supporting the KDE Project

KDE Help Contents

KDE application help index
System man page contents
System GNU info contents
Search for Keyword

Getting the most out of KDE

A Quick Start Guide to the Desktop
Desktop Panel

Control Center

File Manager

Window Manager

3. If you want to look up a particular topic, use the search facility, which you can access by selecting
Search from the File menu of KDE Help.

|

Figure 3: You can access online help via the Directory Browser, which is also known as kfm.

Here’s how to access help in the directory browser.

1. Click on the Directory Browser (also known as the K File Manager, kfm) icon (Figure 3), which
I think looks like a bookend in the shape of a house holding a single file folder.

2. Click on Help in the menu bar of the directory browser or type ALT-H (the ALT key and the letter
H).

3. Choose Contents or press the F'1 key.

4. Then click on whatever topic you want to learn about. Here are the topics that were listed in my
browser:

1. Introduction

2. Philosophy
2.1 Desktop

2.2 Templates

2.3 * kdelnk files
2.4 Internet

2.5 Multi Tasking
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2.6 Look

3. Usage

3.1 Keyboard shortcuts
3.2 How to install new data types
3.3 How to install a new application

3.4 Bookmarks

4. Frequently Asked Questions

4.1 How can I run programs on startup

4.2 How can I start KFM without any opened window
4.3 How can I open a new view for a directory

4.4 How can I select multiple files

4.5 How can I mount a device

4.6 How can I print

4.7 How can I link a URL on the desktop

4.8 How can I look in a TAR file

1.3.1 Getting Help from the Shell

=

Figure 4: Click on the Terminal Emulation icon to launch a shell window.

Want information about a Linux command?

1. Open a shell window by clicking on the Terminal Emulation icon (Figure 4) located in the toolbar
at the bottom of your screen.

2. If you don’t know the name of the command that you want, after the prompt type

apropos keyword

to get a listing of commands that have keyword in their description. The utility apropos is helpful
when you want to find the name of a command, which will probably be something you will do
frequently if you are new to Linux. Suppose you want to find the command to rename a file, use
apropos to help you out.

$ apropos rename

mmove (1) -
mren (1) -
mv (1) -
rename (2) -
rename (n) -

move or rename an MSDOS file or subdirectory
rename an existing MSDOS file

rename files

change the name or location of a file

Rename or delete a command

3. Use whatis, info, or man if you know the name of the command about which you want information
or you know a related command.

The whatis displays a short description of a command or program.

whatis keyword
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For example,

$ whatis date
date (1) - print or set the system date and time

When you want more information about the command, use info or man to access the online
manual. The info program is newer and it contains is more up-to-date information than man.

The info utility is a hypertext system developed by the GNU project® and is distributed with
Linux.

To display documentation (or info) on name, type
info name
Quit out of info by typing q. Below I obtain information on the command to change directories.

$ info cd
NAME
cd - Change working directory

SYNOPSIS
cd ?dirName?

DESCRIPTION

Change the current working directory to dirName,
or to the home directory (as specified in the
HOME environment variable) if dirName is not
given. Returns an empty string.

KEYWORDS
working directory

The info utility uses the Emacs text editor as it’s interface. Table 2 lists some basic commands
for navigating inside the info utility.

Hanual Browser

{Help ) { Quit )

( Hanual Page ]

Figure 5: If you don’t like typing, consider using xman, a manual page browser.
g g g g

Most people who have been using Unix for years, use man to read the online manual. If you don’t
like typing, consider using xman, a manual page browser. Start up xman by typing:

3The GNU project predates Linux and was started by Richard Stallman who has made significant contributions to
Linux. Some people call Linux GNU Linuz to recognize the contributions of the GNU project.
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Commands | What they do
h Invoke the Info tutorial.
CTRL-X 0 Quit this help.
q Quit Info altogether.
Selecting other nodes:
n Move to the "next” node of this node.
p Move to the ”previous” node of this node.
u Move "up” from this node.
m Pick menu item specified by name.
Picking a menu item causes another node to be selected.
f Follow a cross reference. Reads name of reference.
1 Move to the last node seen in this window.
d Move to the ‘directory’ node. Equivalent to ‘g(DIR)’.
Moving within a node:
SPACE Scroll forward a page.
DEL Scroll backward a page.
b Go to the beginning of this node.
e Go to the end of this node.
Other commands:
1 Pick first item in node’s menu.
29 Pick second ... ninth item in node’s menu.
0 Pick last item in node’s menu.
g Move to node specified by name.
You may include a filename as well, as in (FILE-
NAME)NODENAME.
s Search through this Info file for a specified string,
and select the node in which the next occurrence is found.
Table 2: Basic command for navigating in info windows.
xman &

A small window will popup with three buttons (Figure 5). Click on the help button or Manual
Page button to learn more about xman. If you want to browse the user commands, from the
Manual Page window, click on Sections menu and select (1) User Commands. To see the manual
page for a particular command, click on its name or from the Options menu, select Search and
type the name of the command. Or type a string in the search field and xman will display a page
containing that string, if it finds one.

Alternatively, you can display the on-line manual page for name by typing
man name

Here I display the online manual entry for the date command.
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$ man date

NAME
date - print or set the system date and time
SYNOPSIS
date [-ul [-d datestr] [-s datestr]
[--utc] [--universall [--date=datestr]
[--set=datestr] [--help] [--version] [+FORMAT]
[MMDDhhmm [ [CCIYY][.ss]]
DESCRIPTION

This documentation is no longer being maintained
and may be inaccurate or incomplete. The Texinfo
documentation is now the authoritative source.

Scroll around the online manual by pressing the up (1) and down arrow (J) keys.

As you can see from the output of man date, you are encourage to use info instead of man.

Learning Linux commands from the online manuals is a bit like learning English from a dictionary.
As the definitive references for Linux, the online manuals describe all the commands and utilities built
into the system. The better you know Linux, the more useful you’ll find the online help. Tutorial books
are great sources of information for novices.

Exercise
1. Find out about games and other useful program that are on the system by accessing KDE Help.

2. Use the help facility in the Directory Browser also known as the K File manager (kfm) to read
about keyboard shortcuts.

3. From a terminal window, use info or man to learn about the cp program.

1.4 Changing Passwords

There are plenty of people on the net these days who are trying to break into systems. Don’t make it
any easier for them. Change your password periodically and select one that:

e Isn’t in a dictionary.

Isn’t your name or the name of a good friend, relative, or pet of yours.

Isn’t your birthday or some number that other people can find out.

e Contains numbers, punctuation, upper and lower case letters, and/or spaces.

To change your password from your Linux desktop, click on the K icon located in the toolbar at
the bottom of your screen near the left side. Select the Non-KDE Apps submenu and from the Utilities
submenu, select Password. If you would rather use the shell, you can change your password using
yppasswd®. The following text and prompt should appear on your screen:

Changing NIS account information for username on hostname.su.valinux.com.
Please enter old password:

4The name yppasswd stands for yellow pages password because it used Sun’s yellow pages (yp) program to change your
password on all computers in a network. I heard that one of the telephone companies that owns the trademark on yellow
pages filed a suit, so Sun changed the name of the program yp to Network Information Service (NIS). Never-the-less, the
network password program yppasswd as well as several other programs still have yp in their names.
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After you enter your old password, you will be asked to enter your new passsword twice to make sure
that you enter it consistently.

$ yppasswd

Changing password for nblachman
(current) UNIX password:

Retype new UNIX password:

After you enter your new password and the system accepts it, the system may print a message indicating
that your password was updated successfully. Here are messages from two different systems.

passwd: all authentication tokens updated successfully
The NIS password has been changed on magnesium.su.valinux.com.
The yppasswd command rejects passwords that it considers poor choices.

New UNIX password:

BAD PASSWORD: it is based on a dictionary word
New UNIX password:

BAD PASSWORD: is too similar to the old omne

Exercise

Change your password. Make sure to select one that you can remember but is unlikely to be guessed
by other people.
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1.5 Bringing up Netscape

Figure 6: Click on the Netscape icon to launch the Netscape browser.

Among the icons on the left side of your desktop should be one for Netscape (Figure 6). Click on
the icon to launch Netscape or bring up another Netscape window if the application is already running.

b

Figure 7: Click on the K icon to bring up a menu of applications and utilities.

You can also launch Netscape by clicking on K icon (Figure 7) in your toolbar near the bottom
left corner of your screen. Then select the menu item VA Linux Systems and from that menu select
Netscape. Alternatively you can select the menu item Non-KDE Apps, and from that menu select
Internet, and then select Netscape. Since the KDE menus are customizable, your menus might be
arranged differently from mine.

1.5.1 Accessing VA Linux’s Internal Web Site

As you might expect, VA Linux Systems has an internal Web site with information about VA, employees,
departments, events, mailing lists, contact information, the current stock price. To get to the internal
Web site, which is known as VAWeDb, from a Netscape browser, enter the following URL in the location
field of your browser:

https:/ /vaweb.valinux.com

VAWeb is a secure Web site so you will be asked for your username and password to access the site.
On the left side of the VAWeb main page (Figure 8) is a side bar with links to useful sites on VAWeb.
Here’s a brief description of a few of them:

Contact Information A list of names, email address, phone numbers, titles, pager numbers, cell
phone numbers, and fax numbers for people who work at VA.

Employee Info Links to pages with useful information for employees, e.g., answers to frequently asked
questions, conference room names and locations, printer, fax, and copier locations, useful general
phone numbers, business card order form, the holiday schedule (days you don’t have to show up
for work), fun activities in the SF Bay Area, the VA video tape library.

Mailing Lists A list of the VA Linux Systems’ mailing list, which are used to broadcast information
and to allow employees to discuss issues (not necessarily work related).

The Source A Slashdot® style newsletter containing VA Linux Systems news as well as discussions.

How-to’s Links to forms and instructions maintained by the IS department.

5Slashdot.com is a website that has “news for nerds.” It is maintained by Andover.net, which was acquired by VA
Linux Systems in June of 2000.
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Figure 8: VAWeb, the VA Linux Systems’ internal Web site.

Department Pages There are pages for most of the departments.®

1.5.2 Submitting an IS Trouble Ticket or Request

If you are having trouble with software, hardware (desktop or laptop), the network, a fax, a pager, your
office phone or cell phone, email, BAAN, Oracle, or other IS maintained facilities, submit an IS Trouble
Ticket by using your Netscape browser and visiting

https://vaweb.valinux.com/IS /forms /request.html

Click on the Problem Type button to classify your problem or request. Also include a brief description
of your request and then a more detailed description of what you want or need.

Alternatively you can send email to helpdesk@valinux. comor call 408-543-8000. But given a choice
the IS department prefers you to submit a ticket via VAWeb because it is easier to track your request.

1.5.3 Submitting a Facilities Request

If you need something in your office or around the building, including getting into the building, submit
a Facilities Request by using your Netscape browser and visiting

6Please add useful information to your department’s Web pages. For an on-line tutorial on how to create Web pages
and put them up on VAWeb visit

https://vaweb.valinux.com/Training/html
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Figure 9: IS trouble ticket or request form.

https:/ /vaweb.valinux.com /Facilities/forms/request.html

Include a brief description of your request and then a more detailed description of what you want or

need.
If you have an urgent request or an emergency, you can contact Ron Tedder or Willie Scott.

Name | Email | Phone
Ron Tedder | rtedder@valinux.com | 408-542-8691
Willie Scott | wscott@valinux.com 408-543-8023

But given a choice, they would prefer you to submit a request via VAWeb because it is easier to track
and so they can let their management know how they have been spending their time.
Exercise
1. Launch a Netscape browser.
2. Visit the following pages on VA Web:
Facilities and click on 89/47071 Bayside Parkway to see a photograph of the Fremont office.

Video Library under Training and check if any of the video tapes are of interest to you. Place
orders for any that are.

Information Systems and see what information they provide.

Employee Information and click on the Holiday Schedule so you can check the date of the next
pay day and the next holiday.

Employee Information and click on Business Card Order Form and order your business cards,
if you haven’t already done so.
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Figure 10: Facilities request form.

1.6 Handling Your Email

You can select whatever mail program you want to handle your email. From my informal survey, it
seems that most people use Netscape or Mutt. If you are a Mutt user, using your Netscape browser,
you can find Mutt sample files on VAWeb at

https:/ /vaweb.valinux.com/IS/self-admin-tips /samples
Regardless of what email program you use, your email address is
username@valinux.com

If you would prefer using a different email address or if people regularly misspell your name, submit an
IS request and ask for a email alias or several of them. That’s what I did. I receive email sent to

nblachman@valinux.com My real email address.
nancy@valinux.com The email address I printed on my business cards.
nblackman@valinux.com A common way that people misspell my name.

1.6.1 Using Netscape for your Email

Before you can read your email in Netscape, your preferences need to be set up. If you would rather
not configure Netscape, feel free to ask IS to set it up for you. If you want to learn about Netscape
email and set it up yourself, then follow the instructions in this section. You can find more instruction
on Page 84 of Easy Linuz.

1. Start up a Netscape browser.
2. From the Edit menu, select Preferences (Figure 11).

3. From the list of categories at the left of the Preferences window, click on the triangle to the left
of Mail & Newsgroups (see Figure 12) so you can see the items in the category.

12
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Figure 11: From the Edit menu select Preferences to set up your email in Netscape.

| Cateqary
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Figure 12: Click on the triangle to the left of Mail & Newsgroups to see the items in the category.

4. Select Identity and then fill in the blanks. Here’s what I would use if I used Netscape mail”.

Your name: Nancy Blachman

Email address: nblachman@valinux.com
Organization: VA Linux Systems
Signature File: /home/nblachman/.signature

Here are some examples of signature files for people working at VA Linux Systems:

VA Linux Systems Linux IA64/Engineering Sysadmin. 408 542 8661

Home page: http://marc.merlins.org/ (friendly to non IE browsers)
Finger marc_f@merlins.org for PGP key and other contact information

K e e o *
| Lisa Corsetti 408.542.5721 |
| Systems Manager lisa@valinux.com |
| VA Linux Systems http://www.valinux.com |
A e *

"I use Emacs for my email and nearly everything else I do on the computer.

13
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10.
11.

12.

Kit Cosper cosper@valinux.com VA Linux Systems
1-888-LINUX-4U

Charles C. Bennett, Jr. VA Linux Systems

Systems Engineer, 25 Burlington Mall Rd., Suite 300
US Northeast Region Burlington, MA 01803-4145

+1 617 543-6513 +1 888-LINUX-4U

ccb@valinux.com www.valinux.com

If you specify a using your favorite editor so it contains whatever you want attached to the end
of all your messages. If you don’t have a favorite editor on Linux, I recommend using KEdit (a
desktop application), or if you use the shell, kedit, pico, or xemacs. I discuss text editors in the
section on applications.

Instead of a signature file, you can create your own personal card and have it attached to your
messages.

After you have completed the Identity form, click the OK button at the bottom left corner of the
window.

Next we will set up your mail server. As you did before, from the Edit menu, select Preferences.

From the list of categories at the left of the Preferences window, click on the triangle to the left
of Mail & Newsgroups (see Figure 12) so you can see the items in the category.

Select Mail Server and then fill in the blanks. Here are suggestions what I would use if T used
Netscape mail.

Mail server user name: username
Outgoing mail (SMTP) server: smtp
Incoming mail server: pop

Click on the More Options... button.

Select Check for email every 10 minutes and then click the OK button at the bottom left of the
More Mail Server Preferences window.

Click the OK button at the bottom left corner of Mail Server Preferences window.

To read any email you have received, from the Communicator menu, select Messenger Mailboz.
Your Netscape Mail window should popup. Hopefully there will be some email for you.

In the top field of the window, click on any message and it should be displayed in the bottom field
of the window.

1.6.2 Setting Up Your Address Book

Here are instructions for creating an address book.

1.

2.

From the Communicator menu select Address Book.

Add entries to your address book by clicking on the New Card icon at the top left of the Address
Book window. Fill in the card.

14
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1.6.3 Sending an Email Message

How do you send an email message?

1. From the Communicator menu select Messenger.
2. Click on the New Msg icon located in the toolbar of the Mail & Newsgroups window.
3. Address and compose your message.

4. Click on the Attach icon located in the toolbar of the Compose window and specify whether you
want to attach a file, Web page, or personal card. If you attach a file, you must specify in a
browser where the file is located.

5. Check your spelling by clicking on the Spelling icon located in the toolbar. Netscape will offer
suggestions for the “words” that it doesn’t recognize.

6. To send your message, click on the Send icon in the toolbar.

1.6.4 Extracting a Document from an Email Message

What do you do when someone emails you a document?

1. Click on the attachment.

2. Netscape will either open the attachment or it will popup a dialog box and ask where you want
the file stored. Remember where you stored the document, i.e., keep track of the path name of
the form /home/user/dir1/file.

3. If Netscape didn’t open the file, open the file manually by launching the application that you hope
will be able to open the file. The prefix of the file may indicate it’s type (Table 3).

Prefix | Type of file

.doc Microscoft Word

.pdf Adobe Acrobat

.ppt Microsoft Power Point
.sdw StarOffice

.x1ls Excel Spreadsheet
.eps PostScript

.ps PostScript

.gif Graphics

.jpg Graphics

.jpeg | Graphics

Table 3: The prefix of a file may indicate its type.

If the prefix of the file is .doc, you should be able to open the file with StarOffice. If it doesn’t
open, then consider using Citrix (which I describe later in this course) and Word to open the
document.

Exercise

In this exercise, you will set up your email and address book.
1. Start up Netscape.

2. Set your preferences, including your identity, email address, and organization.

15
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3. Set up your signature file or your personal card.
4. Put your manager and at least one of your co-workers in your address book.

5. Compose a message telling what you’ve been hired to do, where you worked before joining
VA Linux Systems, and a couple of your hobbies or outside interests and send the message to
all@valinux.com introducing yourself.

1.6.5 Signing up for Mailing Lists

VA maintains mailing lists to propagate information and to promote discussions. Some mailing lists
are moderated, i.e., edited or filtered by someone. On other mailing lists, everything goes. To see the
current mailing lists, using your Netscape browser visit

https:/ /lists.valinux.com/lists/listinfo

You’ll be asked for your username and password to access information about the lists.

To subscribe to a list, click on the name of the list on the mailing lists’ web page. Then fill in
the form, giving your email address (the entire thing, e.g., nblachman@valinux.com) and a password.
Choose a password different from the one that you selected to log on to the system because this password
is going to be emailed to you once a month, in case you forget it

I recommend that you subscribe to the mailing list for your department, group, or area of specialty,
e.g., accounting, admin, eng-all, finance, marketing, ps, sales, support, tech, training. There should be
no need for you to subscribe to the mailing list all@valinux.com. User are automatically subscribed
to it indirectly. That is, users are subscribed to a location list, e.g., Fremont, offsite, San Diego, or
Sunnyvale. Any posting to all@valinux.comis forwarded on to the location lists. If you find that you
do not receive any email sent to the list corresponding to your location or to all@valinux.com, check
whether you are subscribed to your location list and if you aren’t, sign up for it.

Exercise
This exercise is to acquaint you with the mailing lists at VA Linux systems.
1. Check out the list of mailing lists.

2. Pick at least three lists and subscribe to them. Don’t worry about subscribing to too many, you
can unsubscribe whenever you wish.

1.6.6 Setting up Vacation Email Auto-responding

If you are going to be out of the office and unable to check you email, consider setting up the vacation
program to automatically respond to your incoming messages. Here’s how to set up the vacation
program.

=

Figure 13: Click on the Terminal Emulation icon to launch a shell window.

1. Open a shell window by clicking on the Terminal Emulation icon at the bottom of your screen.
The icon shows a computer with a computer screen (Figure 13).

2. In the shell window, after the shell prompt type:
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vacation

Be aware that by typing vacation you launch the program and everyone who sends you email
after that point will receive your vacation message and if you don’t change the permissions on
your .forward file you may stop receiving your email. If you just ran vacation as an experiment
to see how it works, delete the file .forward after you are through experimenting by typing;:

rm ~/.forward

The ~ is a shorthand notation for your home directory, which is probably /home/username.

3. The vacation program will launch an editor so that you can edit the file .vacation.msg, which
will be automatically sent to those who send you email. Here’s the message that the vacation
program uses if you don’t change it.

Subject: away from my mail

I will not be reading my mail for a while.
Your mail concerning "$SUBJECT"
will be read when I’m back.

“$SUBJECT” will be replaced by the subject of the message being send to you.

The vacation program launches your default editor® or vi. If you are satisfied with the default
message (shown above) and you are using the vi editor, type :q, which indicates that you want to
quit out of the editor. Make changes to the file using vi commands listed in Table 6. I've included
more about using the vi editor in the section on using a text editor. I've also attached a couple
of quick references at the end of your course notes.

4. Change the permissions on the file . forward, which the vacation program has left in your home
directory by typing

chmod 600 ~/.forward

5. When you return from vacation or where ever you are, turn off the vacation program by typing
rm ~/.forward

to remove the .forward file in your home directory.
Using your Netscape browser, you can find these instructions on VAWeb at

https://vaweb.valinux.com /IS /misc/vacation.html

8Later in this course, I show how to change your default editor.
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1.7 Understanding your Files and Directories

Because the systems at VA are networked, regardless of which system you log on to at VA, you will
find yourself in your home directory, which is typically /home/username. So you need not be logged on
to the computer at your desk to access your files.

The files in your home directory are owned by you; no one (except the super user) may change or
view them unless you grant them permission to do so.

1.7.1 Browsing your Files and Directories

You can browse files and directories by using the K File Manager (kfm), which is sometimes referred to
as the Directory Browser® (a graphical program) or the shell. Not only can you view and manipulate
files and directories (folders) with kfm, but you can also browse the Web with it.

|

Figure 14: You can view files and folders using kfm.

Here’s how to use kfm.

1. Click on the kfm icon (Figure 14). Then you can browser the files and folders on your system
(Figure 15).
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Figure 15: Using kfm you can view the files and folders on your system.

2. If you want to view your files and directories similar to how they are displayed on a Windows’
system, select the menu item Show Tree from the View menu of the Directory Browser. Then
you will see the directory hierarchy on the left side of the window and the icon view on the right
side (Figure 16). Click on the triangle to the left of a folder or on the folder itself to display the
contents of the folder.

3. Click icons of images to launch applications or see documents.

9The Directory Browser is a desktop application. It has not related in any way to the Netscape Browser, except that
they both have the work ‘browser’ in their names.
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Figure 16: From kfm, select Show Tree from the View menu, to display the directory hierarchy on the
left side of the window.

There are a couple of different ways to create a directory or folder. From the File menu, select
New and then select the submenu item Folder. Alternatively, you can click the right button of
your mouse on the white space between files and folders. From the pop-up menu, select New, and
then choose Folder from the submenu. Then in the dialog box that appears type the name of the
new folder.

L7

Figure 17: You can browse files and directories from a terminal window.

Here’s how to browse directories and files using the shell.

1.

Click on the Terminal Emulation icon (Figure 17) to launch a shell window. When the window
starts up, you will be placed in your home directory, which is typically /home/username.

. Type 1s after the shell prompt to see the files and directories in your current working directory.

Change your current working directory by using cd. Table 4 lists some useful commands for
working with files and directories. As you may notice, the names of most built-in commands are
written with lower-case letters.

Exercise

1.

Browse the files and directories by using the Directory Browser or the shell.
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Shell Commands

What they do

pwd Print the current working directory.

1s List the names of the files.

1s -1 List the names and information about each file.

1s -t List the most recently modified files first.

cd Change to your home directory, i.e., /home/username.

cd ~ Change to your home directory.

cd “user Change to user’s home directory.

cd dir Change to the directory dir in the current working
directory.

cd /dir Change to the directory /dir.

cd .. Change to the parent directory of the current working
directory.

mkdir dir Create the directory dir in the current working direc-
tory.

mkdir /dir Create the directory /dir.

rmdir dir Remove the directory dir. The directory must be
empty before rmdir will remove it.

cat file(s) Print the contents of file(s).

less file Print the contents of file, one page at a time.

more file Print the contents of file, one page at a time. The
command more has fewer capabilities than less.

head file Print the first 10 lines of file.

head -n file Print the first n lines of file.

tail file Print the last 10 lines of file.

tail -n file Print the last n lines of file.

mv oldName newName
cp original new
rm file(s)

rm -f directories

Rename the file oldName to newName.

Copy the file original to new.

Remove file(s).

Remove directories recursively, i.e., all files and direc-
tories in the directories.

cmp fileA fileB

diff fileA fileB

Finds the first place where fileA is different from fileB.
cmp returns nothing if the two files are the same.
Report the differences between fileA and fileB.

Table 4: Shell commands for working with files and directories.

1.7 Understanding your Files and Directories

2. Create some structure to your home directory by creating the following folders or directories:

Name What to put in it

documents | For your documents

images For graphic files

tmp For temporary files.

todo For keeping track of what you need to do.
misc For miscellaneous files.

3. Move files in your home directory into the directories you just created.
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1.8 Starting Applications from Your Desktop
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Figure 18: Click on the K icon in the toolbar and then on the application you wish to launch.

Launch an application by clicking once on its icon or by selecting the application from a menu. Click
on the K Menu icon in the toolbar and a menu (Figure 18) filled with applications and categories will
popup. Click one of the categories to see more applications and then click on the application name and
the application will launch.

Exercise

1. Browse the popup menu that appears when you click on the K icon shown in Figure 7 and find
at least a half a dozen utilities and applications that might be useful to you.

1.8.1 Using a Text Editor

If you want to create a letter or document, you can get the information into your computer by using a
word processor, such as StarOffice (which you’ll learn about in the next section) or Applixware!?, or a

10people at VA Linux Systems more people use StarOffice than Applixware.
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text editor, a program designed for storing and manipulating text. Unlike a word processor, you can’t
change font faces in a text editor. They are just intended for entering plain text. I prefer using a text
editor to a word processor because it is a simpler application and more robust, i.e., rarely crashes.

Figure 19: The easiest text editor to learn is KEdit.

If you just want to create a simple document, consider using KEdit. The text editor KEdit is a
mouse-based text editor. In other words, navigate around your file with your mouse. Here’s how to use
KEdit.

1. Click on the KEdit icon (Figure 19), which looks like a pencil writing on a notepad. A text editor
window will pop up.

2. Just click your mouse on the position where you want to add text and then type. Select text you
want to delete and then type the DELETE key, the BACKSPACE key, or select Cut from the FEdit
menu.

3. Once you have completed your edits, save the document by either clicking on the floppy disk icon
just above the text window or select Save or Save as ... from the File menu. The first time you
invoke Save, you will be asked for a filename for what you have just created. Subsequent times
will save the content of your text editor to that filename. The Save As... option allows you to
specify a different filename.

There are many editors available from the shell. Pico is a simple text editor that is recommended
by Carl Strasen a senior technical writer at VA who writes the documentation VA Linux Systems
distributed with the systems we sell. Here are instructions for using Pico.

1. Start up a terminal emulation or shell window.
2. Type pico after the prompt, and the editor will start up. There are two menus: File and Options.

3. Type in the Pico window to enter text. Commonly used commands are displayed at the bottom
of the Pico window. I’ve listed those commands in Table 5.

Commands | What they do
CTRL-G Get help.
CTRL-X Exit.

CTRL-O Write out, i.e., save.
CTRL-J Justify.

CTRL-R Read file.
CTRL-W Where is.
CTRL-Y Previous page.
CTRL-V Next page.
CTRL-K Cut text.
CTRL-U Uncut text.
CTRL-C Current position.
CTRL-T To spell.

Table 5: Commonly used command for working with files in the Pico editor.
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Two of the most popular text editors on Linux are vi (actually vim, an improved version of vi)
and Emacs. The vi editor is distributed with all version of Unix and Linux. The Emacs editor, which
was developed by Richard Stallman, the founder of GNU, is available for lots of types of computers.
It is the most powerful editor I have come across. Actually it is more than an editor; it is a working
environment. It includes a shell, a spelling checker, online help, search tools, among other things.

Both vi and Emacs have an extensive set of commands that take at least a few hours for most people
to learn. But just like typing, once you learn the commands, you can create documents and files rapidly.

To use both vi and Emacs, start up a terminal emulation or shell window. See Table 6 for commands
for using vi.

Commands | What they do

Starting a vi Session

vi file Edit file.

Inserting Text

To leave the insert mode, press ESC.

Append text after cursor.

Append text after the end of current line.

Insert text before cursor.

Insert text before the beginning of the current line.
Open a new line before the current line and insert text.
Open a new line after the current line and insert text.
:r file Read file and insert after the current line.

Moving the Cursor

Click your mouse where you want to position the cursor.
Use your arrow keys to move the cursor.

OO0 H H =@

k Move up.

j Move down.

h Move left.

1 or SPACE Move right.

W Move to the next word.

b Move to the previous word.

e Move to the end of the next word.

Move to the beginning of the line.

$ Move to the end of the line.
Deleting Text

X Delete the current character.

nx Delete n characters beginning with the the current character.
Save Text and Exit vi

ZZ or :wq Save file and exit vi.

W Save current file but do not exit.

:ufile Save file but do not exit.

:q Quit out of vi.

:q! Quit out of vi without saving any changes since the last write.

Table 6: Command for working with the vi editor.

Table 7 lists just a small set of the commands for using Emacs. See the reference card included at
the end of your notes for a much more extensive list of commands.

1.8.2 Creating Documents using StarOffice

StarOffice has similar capabilities to Word and you can use StarOffice to read Word documents. StarOf-
fice is actually a suite of applications. It has a document creation tool, a spreadsheet, and a presentation
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Commands What they do
Starting an Emacs Session
emacs To enter Emacs.
emacs file Edit file.
Leaving Emacs
CTRL-Z Suspend Emacs (or iconify it in the Linux desktop)

CTRL-X CTRL-C

Exit Emacs permanently.

CTRL-X CTRL-F
CTRL-X CTRL-S
CTRL-X S
CTRL-X I
CTRL-X CTRL-W

Files

Read a file into Emacs.

Save a file.

Save all files.

Insert contents of another file.
Write buffer to a specified file.

CTRL-H or F1

Getting Help
Get help.

CTRL-H T Access the Emacs online tutorial.

CTRL-X 1 Remove help window.

CTRL-H A Apropos: show commands matching a string.
Inserting Text
Just type the text you want to enter.
Motion

CTRL-B Move backwards a character.

CTRL-F Move forwards a character.

ESC-B Move backwards a word.

ESC-F Move forwards a word.

CTRL-A Move back to the beginning of the line.

CTRL-E Move forward to the end of the line.

ESC-A Move backwards a sentence.

ESC-E Move forwards a sentence.

ESC-< Move back to the buffer beginning.

ESC-E Move forwards the buffer ending.

CTRL-V Scroll to the next screen.

ESC-V Scroll to the previous screen.
Killing and Deleting

DEL Delete backwards a character.

CTRL-D Delete forwards a character.

ESC-DEL Delete backwards a word.

ESC-D Delete forwards a word.

CTRL-K Delete a sentence.

Table 7: Command for working with the Emacs editor.
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tool. Unfortunately the version of StarOffice that we have at VA is not as robust as you might like it
to be. So I recommend when using StarOffice that you save your work frequently.
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Figure 20: StarOffice is a suite of applications.
Here are instructions on using StarOffice.

1. Start StarOffice by clicking on the StarOffice icon on your desktop or selecting StarOffice after
you click on the K icon in your toolbar at the bottom of your screen. You can also start StarOffice
by typing soffice in a shell window. A window will pop with icons for launch the StarOffice
applications (Figure 20).

2. Turn on the automatic save option to protect against losing your work if StarOffice crashes. From
the Tools menu, select Options. Click on the plus sign to the left of the word General in the
Options window (Figure 21) to display the different type of general options.

3. Check off the box to automatically save your work every 5 minutes.

I also recommend setting the number of undo steps to at least 50 (Figure 23) so that you can
backup the last 50 changes you made. It comes in handy when you make a mistake and want to
recover what you produced previously.

Click the OK button at the bottom of the window.

4. To create a new document, click on the icon corresponding to what you want to do:
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Figure 21: Set automatic save by selecting the Save options.
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Figure 22: Set automatic save in StarOffice by selecting the Save options.

26



INTRO TO VA’S LINUX DESKTOP

1.8 Starting Applications from Your Desktop

5.

Undo
Count of steps S0 =

Figure 23: in StarOffice, set the number of undos to at least 50.

Icon Name What they do

New Drawing Create a graphic.

New HTML Document | Create a Web page.
New Presentation Create a presentation.
New Spreadsheet Create a spreadsheet.
New Text Document Create a text document.

To open an existing document, either StarOffice or Word, from the File menu, select Open and
in the Filename field, either type the filename or use your mouse to select the file name using

StarOffice’s file browser (Figure 24).
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Figure 24: Type or select the name of the file you wish to open using the StarOffice file browser.

6. To exit out of StarOffice, select Ezit from the File menu. If you click on the X in the upper right
corner of your window, StarOffice may not shut down cleanly so you might not be able to restart
it unless you kill the running application or reboot your system. Towards the end of this course,
I describe how to kill a running program and how to reboot your computer.
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Exercise

1. Create a document with StarOffice.
2. Create a spreadsheet with StarOffice.

3. Create a three page presentation with StarOffice.

1.8.3 Working with Documents

See Page 50 of Fasy Linux.

1.8.4 Running Windows from your Linux Desktop

VA hopes that you can do all that you need to do using Linux. For those hopefully rare occasions when
you have no choice but to run Microsoft Windows, you can use Citrix to access Windows applications
that are run on an NT server.

Citrix is not part of the standard IS distribution. If you anticipate that you will need to use a
Windows application, ask the IS department to install Citrix on your system.

Figure 25: Click on the Citriz icon to run Windows applications from your Linux desktop.

Here are instructions on how to launch Citrix from your Linux Desktop.

1. Click on the Citriz icon (Figure 25) on your desktop, which should launch the Citrix ICA Client
and a window (Figure 26) should pop up showing the applications you have been given permission
to run.
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Figure 26: Click on the Citriz icon to run Windows applications from your Linux desktop.

2. To launch a Windows application, double click on the name of the application that you want
to run or select it with your mouse so it is highlighted and then click on the button with the
lightening bolt. Within a few seconds, a black window should pop up.

3. Enter your login and your password and then the application should launch.
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To open a document that is in your home directory (or a subdirectory in your home directory),
from the File menu select Open and then select the file.

Save all documents you create or edit to drive H: to the folder with your name on it. If you do,
then they will be accessible from your Linux desktop.

To print, from the File menu select Print and a print dialog box should pop up. Click on Name
field to select the printer where you want your output printed. Warning: Not all printers listed
are hooked up to the NT server. So if you print and your document doesn’t appear on the printer,
try printing to another printer.

Exit out of the application by selecting Ezit from the File menu. I don’t recommend clicking the
X in the upper right corner of the application window otherwise the Citrix application window
might automatically startup the next time you launch your Linux desktop.

Exit out of Citrix by either clicking the X in the upper right corner of the Citrix ICA Client
window or selecting FEzit from the Entry menu.

Exercise

If the Citrix icon is on your desktop, then

1.

A

Launch Citrix.

Launch Microsoft Word.

Create a Word document.

Print it.

Exit out of work without saving the document.

Exit out of Citrix.

1.8.5 Syncing up your Pilot or Visor on Linux

There are several programs on Linux for syncing up your Palm Pilot or Handspring Visor on Unix. In
KDE there is a program called KPilot.

1.
2.

Plug your cradle into your computer if you haven’t already done so.
Put your Palm or Visor in the cradle.

Start up KPilot by clicking your mouse on the large K icon located in the toolbar at the bottom
left of your screen. A menu should popup. Then select the Utilities submenu and then KPilot,
which should launch KPilot. On your screen should appear a window that looks like Figure 27.

Click on the hot-sync button on KPilot (Figure 28), which is near the top left corner of the KPilot
window.

Click on the hot-sync button on your cradle. A window will popup to tell you the items being
sync’ed. A message will appear at the bottom lower left of your KPilot window when the not-sync
is complete.

If you are willing to use the shell, I recommend using the program jpilot instead of Kpilot.

1.
2.
3.

Plug your cradle into your computer if you haven’t already done so.
Put your Palm or Visor in the cradle.

In a terminal emulation window, start up jpilot by typing
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Figure 27: Use KPilot to sync up your Palm or Visor with your computer.
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Figure 28: The hot-sync button on KPilot.

jpilot
On your screen should appear a window that looks like Figure 29.
4. Click on Sync button.

5. Click on the hot-sync button on your cradle. A window will popup giving you a status report on
the the data that is being sync’ed.

1.8.6 Switching between Applications

Linux is a multi-tasking operating system, which means that you can run more than one application at
a time. There are several ways that you can switch to an application so that it appears in front of all
others on your screen.

e Click on the rectangle at the top of the screen with the application’s name or icon (Figure 30).

e Click on the Windowlist icon (Figure 31) to see the applications that are currently running.

Your screen is of a limited size. Linux is built to handle multiple virtual windows, which are
windows that may not be displayed on your screen. You may run a terminal window and the
Directory Browser in one virtual window and Netscape in another virtual window. The pop-up
menu displayed when you click on the Windowlist icon show the applications running in each of
your virtual windows (Figure 32).

e By click on one of the rectangles in the toolbar that look like some Pez candy (Figure 33), you
can switch virtual windows. Then click anywhere on one of the application windows to bring it
to the foreground.
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Figure 29: I recommend using the program jpilot instead of Kpilot.

Page 39 of Fasy Linuz also has a description of how to switch applications.

1.8.7 Moving Data between Applications
See Page 56 of Easy Linuz.

1.9 Printing

Fortunately VA has printer around the office most of which are on the VA network. There are some
large fast ones. Some individuals have printers in their offices. You can direct your output to printers
on the network.

1.9.1 Printing a Document on a Specific Printer

If you don’t specify a printer, when you print a document it will be printed on your default printer. I

am not aware of any graphical desktop application that will provide you with the name of your default

printer. So you can either find out the name by asking IS or you can find it yourself by using the shell.
Here’s how you can find out the name and location of your default printer:

1. Start up a terminal window by clicking on the Terminal Emulation icon (Figure 17) on the tool
bar.

2. After the shell prompt, type
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Figure 30: You can switch to application by clicking on the rectangle at the top of the screen with the
application’s name or icon.
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Figure 31: Click on the Windowlist icon to display the window in which the running applications can
be found.

echo $PRINTER

Here’s the name of my default printer

$ echo $PRINTER
koster

If no printer name was displayed, then read the next section to learn how to set up your default
printer.

3. Using the Netscape browser, look up the location of your default printer on VAweb at
https:/ /vaweb.valinux.com/Training /Employeelnfo /printers.html

If you want to print on a printer other than your default printer, you need to specify the name of
your printer in the print command. Some applications, such as StarOffice, will present you with a menu
of printers. Click on the name field and a menu of the available printers should pop up (Figure 34).
Select the one where you want your file printed.

When using other applications, such as Netscape, When you select Print from the File menu, some
applications , e.g., Netscape, will display the Print dialog box like the one in Figure 35. Notice in the
Print Command field there is the command 1pr, which sends your document to a printer. Direct your
output to the printer named printer by entering the following command in the Print Command field:

lpr -Pprinter

If you want to print a document on the printer named koster, in the Print Command field, you
would enter

lpr -Pkoster

If you mistype the name of the printer, your output will be printed on your default printer.

1.9.2 Setting up a Printer as your Default

If you would rather only use the Linux desktop, i.e., the graphical user interface, then ask IS to set your
default printer. This section is only for those of you who are adventurous.

There are special variable, known as environment variables, that tell the shell how to behave in
certain circumstances. For instance, HOME is the name of your home directory. The variable MATIL is set
to the standard file where your email arrives. If the EDITOR variable is set to the name of your favorite
editor, some programs will start up that editor automatically.

Environment variable names are specified in terms of only uppercase letters. The command printenv
prints all of your environment variables.
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Figure 33: See the applications running in each of the virtual windows.

$ printenv

HOME=/home/nblachman

USER=nblachman
PATH=/usr/local/bin:/bin:/usr/bin:/home/nblachman/bin: .
MAIL=/var/spool/mail/nblachman

SHELL=/bin/bash

GROUP=training

HISTFILESIZE=200

PRINTER=koster

Don’t worry if you don’t understand what all these environment variables do. I’m only going to
discuss the variables PRINTER and EDITOR.

An environment variable is a regular variable with added capabilities. When you define or redefine
a variable, make it an environment variable by exporting it as follows:

export variableName="value"

However, for historical reasons, you’ll more often see definitions of environment variables on a separate
line from the exporting statement.

variableName="value"
export variableName

I encourage you to write the variable definition on the same line as the export so that you don’t have
to retype the variable name and possibly misspell it.

After assigning the value printername to the variable PRINTER and exporting it, your default printer
will be printername in your current shell (and any shells that you create from that shell). But the
definition won’t be used in any other terminal emulator you start up. Also when you logout, the
definition won’t be saved.
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Figure 35: Some applications use the command 1lpr to print a file.

Add the definition of your default printer to your .bash profile file, the Bash shell’s login ini-
tialization file, which is automatically executed whenever you log in. If your default shell is Bash'!,
your .bash profile contains definitions used to manage your shell (typically environment variables
definitions). To specify your default printer, replace printername with the name of the printer you
want as your default, and add the following line to your .bash profile .

export PRINTER="printername"

Here is the line that set up my default printer in my bash profile file.
export PRINTER="koster"

For the printer you specified in your .bash profile to become your default, the file needs to be
executed, which happens when you log on to the system. So you could log out and log back in again to
set your default printer. But there’s an easier way. You can simply execute the file .bash profile by
typing . (period) followed by the name of your bash profile file, i.e.,

. 7/.bash_profile

As T mentioned before, ~ is a shorthand notation for your home directory. After executing the command
above, your default printer in your current shell and any shell after you re-login will become what you
defined it to be in your .bash profile.

' There are several shells on Linux. Bash is one of the friendliest and is also among the most versatile and powerful.
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Exercise
1. Using your Netscape browser, find the name of the printer closest to where you sit by visiting the
Web page
https://vaweb.valinux.com/Training/Employeelnfo/printers.html
2. Make the closest printer your default printer by defining the environment variable PRINTER to be
the name of the closest printer in your .bash_profile and then executing that file.
3. Print your .bash_profile by typing

lpr ~/.bash_profile

and see if it’s printed on the printer you made your default printer.

4. Override the default value by printing your bash profile on a different printer. Check that it works.

1.10 Specifying your Default Editor

The way you specify your default editor is similar to how you set up a printer as your default. Set the
value of the environment variable EDITOR to the name of the editor you want to be your default and
add the definition to your .bash_profile file. Here’s the line you would add to your .bash_profile if
you wanted pico as your default editor.

export EDITOR="kedit"

1.11 Reading from a Floppy or CD-ROM

You can copy MSDOS or Unix files from floppy disks or CD-ROMs. It is not as easy as on a Macintosh
or Windows, i.e., you can’t just insert a floppy and click on it. If you would rather not use the shell,
ask IS to set up an icon or menu item that you can use to access a floppy or CD-ROM.

1.11.1 Reading, Writing, and Moving MS-DOS Files

There is a public domain collection of tools called mtools for reading, writing, and moving files from
an MS-DOS system (typically a floppy or CD-ROM) to or from your Linux System. Table 8 lists some
of the commands included in mtools.

Commands What they do

mdir a: List files on a DOS disk.

mformat a: Format a dos floppy.

mcopy a:file . Copy a file from a DOS floppy to your current directory.
mcopy filel a:data | Copy filel to a DOS floppy and rename the file data.

Table 8: Examples of how to use mtools to access DOS files.

1.11.2 Mounting, Formating, and Unmounting Floppies and CD-ROMs

Here’s what you need to do to read or write to a disk using the shell:

1. Insert the disk (floppy, CD-ROM, or other type of disk) into a drive on your system.
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2. In a terminal emulation window, mount the device, i.e, the floppy or CD-ROM. When mounting
a device, Linux checks the status of the device and makes it ready to access. To mount a floppy,
type

mount /mnt/floppy

To mount a CD-ROM, type

mount /mnt/cdrom

3. After the floppy or CD-ROM has been successfully mounted, then you can access the disk. You
can copy or move files to and from the disk using cp and mv. Here’s how to copy files from a
CD-ROM to your home directory

cp /mnt/cdrom/* ~

If you want to copy all the files from the CD-ROM, use the -r option to cp, which will copy
all directories recursively, i.e., copy all directories and all files and directories contained in those
directories. If you want to preserve the original files’ owner, group, permissions, and timestamps
(date and time of last modification), use the -p option to cp:

cp -pr /mnt/cdrom ~

A floppy needs to be formatted before you can mount and write to it. You can either buy formatted
floppies or you can format them yourself.

As T showed you before, you can format a floppy in DOS format using mformat (part of mtools).
The current version of mtools supports VFAT style long filenames. If a Unix filename is too long
to fit in a short DOS name, it is stored as a VFAT long name, and a companion short name is
generated. This short name is what you see when you examine the disk with a pre-7.0 version of
DOS. Table 9 shows some samples of short names:

Long Name | MS-DOS Name | Reason for the Change
thisisatest | THISIS™1 Filename too long.
alain.knaff | ALAIN™1.KNA Extension too long.
pron.txt PRN™1.TXT PRN is a device name.
.abc ABC~1 Null filename.

hot+cold HOT_CO0~1 Tllegal character.

Table 9: Examples of how to use mtools to access DOS files.

Use the command fdformat to format a floppy, which builds a file system. The command also
verifies the file system, i.e., it checks that there aren’t any bad sectors. Table 10 shows commands
for formatting disks of different capacities.

Command Disk Capacity

fdformat /dev/£d0 3.5” disk in drive a: (1.44 MB).
fdformat /dev/£fd0D720 | 3.5” disk in drive a: (720 kB).
fdformat /dev/fdOH1440 | 3.5” disk in drive a: (1.44 MB).
fdformat /dev/fdOH2880 | 3.5” disk in drive a: (2.88 MB).

Table 10: Commands for formatting disks of different capacities.

Once you’ve formatted a disk, mount it and then you can copy files to it.

Below are the commands to format a 1.44 MB floppy, mount it, and copy filel and file2 from
your current working directory to a floppy.
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fdformat /dev/fd0
mount /mnt/floppy
cp filel file2 /mnt/floppy

From the shell, you can change directories to the floppy or CD-ROM using the commands:
cd /mnt/floppy

or
cd /mnt/cdrom

4. You can’t eject a CD and you shouldn’t eject a floppy until after you unmount it. The system
won’t let you unmount it if you are using it or if your current working directory is on the disk.
So exit out of any applications on the disk and change directories so that the current directory in
any of your windows or applications is not on the disk. Then you should be able to unmount a
floppy as follows:

umount /mnt/floppy
Here’s the command for unmounting a CD-ROM:
umount /mnt/cdrom

When you write to a floppy, the contents is not necessarily written to a floppy immediately. It
may be written to a buffer. The contents of the buffer will be written to disk when you unmount
the floppy. If you eject a floppy before unmounting, you may find that the floppy won’t have the
files that you wrote to it.

1.12 Customizing your Desktop
See Part 6 on Page 106 of Fasy Linuz.

1.13 Killing a Process

There are times when you might want to stop a program from running. An instance of a running
program is called a process. Each process is assigned a number called its process-id.

You can view the processes that are running and kill any of them using either KDE Task Manager.
Here are instructions on how to start up and use the KDE Task Manager:

1. From the K icon at the left side of your toolbar, select the System submenu, and then select Task
Manager. The KDE Task Manager window will popup, showing you your running processes. The
window is updated periodically.

2. You can terminate a process by selecting it and then clicking on the Kill task button that is in
the lower right corner of the window.

3. A dialog box will pop up to verify that you want the task manager send a SIGKILL signal to the
process you selected. You can either continue (kill the process) or abort your request.

Naturally, you can also review and manager your processes from the shell. From a terminal emulation
window, use the command ps to see the processes you are running along with their process-id’s (shown
in the first column). The ps command reports the process status.

$ ps

PID TTY STAT TIME COMMAND
8896 pO0 S 13:51 ical
9588 pO R 0:00 ps
19593 pO S 0:00 bash
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The process-id comes in handy should you want to kill (or terminate) a process. I'm using the word
kill because there is a Linux command with the same name that terminates processes. I kill the process
with process id 8896, which is associated with the ical program (a calendar program) as follows:

$ kill -9 8896
[1] Killed ical

The line following my kill command indicates that the running ical program has terminated.

1.14 Logging out, Rebooting, and Shutting Down

Al

Figure 36: Click on this icon to exit out of your Linux desktop.

To log off your system, first exit out of your Linux desktop by either

e Clicking on the Shutdown icon (Figure 36) located in the toolbar at the bottom of your screen
and then click on Shutdown in the dialog box that pops up. Another dialog box may pop up
asking if you want to terminate the applications you are currently running.

e Clicking the right button of your mouse on the background of your desktop and then selecting
Log out from the popup menu.

e Positioning the mouse on your desktop (not on a window) and clicking the left mouse button and
then selecting Log out from the popup menu.

e Hitting the control key (CTRL), then the alt key (ALT), and then the backspace key (BACKSPACE).

If don’t see a login prompt after you exit from your Linux desktop, you can log off the system by
either:

e Typing logout after the shell prompt.
$ logout

¢ Hitting the control key and then the D key, which is typically designated with the notation
CTRL-D.

Rebooting, Halting and Powering Off your System

The IS department would prefer if you log off your system when you leave the office but not turn it off.
Unlike Microsoft Windows, Linux is a robust, stable operating system that can be left on for months
with no problems. I’ve heard that VA has computers that have not been shutdown or rebooted in years.

If you want to shut off your Linux system, why shouldn’t you just turn off the power switch? Here
are a couple of reasons:

1. Linux writes changes you make to files to a buffer cache (a temporary location) and then periodi-
cally writes these changes to your hard drive. If you shut down your system by hitting the power
switch, your system may not write the files in the buffer cache to disk (your hard drive) and so
they may be lost or corrupted. So do not shut down your system by hitting the power switch
unless you don’t mind losing or corrupting some of your files.

2. If you shut off your Linux system without powering it down, then when your system is rebooted
it will run a program called fsck, which takes a long time checking and repairing the file system.
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If you are having problems terminating a process or launching an application, try fixing problems by
exiting out of your Linux desktop and logging off your system. Reboot when there is a major earthquake
or other natural disaster or in desperation. Never-the-less, I'll tell you how to reboot, halt, and power
down a Linux computer. There may be occasions when your system seems messed up, e.g., there are
programs that you can’t terminate or programs that you can’t start. Rebooting your system fixes some
problems.

To reboot or shutdown your system, first exit out of your Linux desktop as I described in the previous
section.

e If you do not have access to the superuser password, which usually only system administrators
have, then reboot your system by depressing and holding down the control key (CTRL), the alt key
(ALT), and the delete key (DEL), which is commonly denoted as CTRL-ALT-DEL. Be aware that
you won’t be asked if you want to reboot the system; it will immediately start rebooting itself.
After the system prints “Please stand by while rebooting the system” (or something similar to
that), you can safely shut off your system or just let it reboot itself.

e If you have access to superuser permission, become root by either logging on to the system as
root,

$ login: root
Password:

or using the su command to temporarily become root

$ su
Password:

Then run the run either halt, reboot, or poweroff depending on what you want to do.

1.15 Logging in Remotely
How you log on to your computer at VA Linux Systems depends on what sort of a connection you have.
e If you have a modem, you can dial up VA using

Toll Free: (888) 245-5689

and follow the instructions that you can access from your Netscape browser by visiting
https:/ /vaweb.valinux.com/dialup

¢ If you have access to a Linux or Unix computer on the Internet, you can log in to your VA account
from a command line using

ssh -1 username shells.valinux.com

where username is your login name or username on the system. Typically your username is the
first initial of your first name followed by your last name, e.g., nblachman.

e VA Linux Systems is providing DSL service to some employees. Submit an IS request if you are
interested in being considered for the VA DSL program.
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1.16 Reading Email Remotely

There may be times when you aren’t in the office but you want to read your email. You can dial up a
VA computer and read your email as you normally do.

If you are connecting to the Internet, you can set up your Netscape to read your email. Do not
download your email and allow Netscape to mark it as deleted if you want to have it available again
from the Internet at work.

For instructions on how to pick up your email from outside VA Linux Systems, using your Netscape
browser visit

https://vaweb.valinux.com/IS /email /imap-ssl.html

1.17 Conclusion

I sincerely hope this practical introduction has helped you to become (more) proficient with Linux. I
have tried to anticipate your questions and problems. Please let me know if I have missed something
or described something incompletely or incorrectly. I welcome all comments. I look forward to hearing
from you.

Nancy Blachman

Technical Training Manager
VA Linux Systems, Inc.
1382 Bordeaux Dr.
Sunnyvale, CA 94089
nancy@valinux.com
408-542-5715

408-621-7043 cell

Don’t worry if you don’t feel adept at what I presented in this course. Learn new things when you
need to do something. Pick it up a little at a time. That’s what I did and continue to do.

1.18 Quiz

What would a course be without a test. There is a prize for those who score high. Email your answers
to nancy@valinux.com.

The Linux Desktop
1. After you log in, how do you bring up your Linux Desktop?
(a) Tt comes up automatically.
(b)
(c)
(d)
)

(e) Type kde

Type x
Type startx
Type desktop

The Web
1. What is the URL for VA Linux Systems’ internal web site?

(a) vaweb

(b) www.vaweb.com

(c) https://vaweb.valinux.com
)

(d) valinux.vaweb.com
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(e) valinux.com/ vaweb
2. Where can you find the form on VAWeb for submitting an IS trouble ticket?

3. What is VA Linux Systems’ ticker symbol and what is today’s price range and where can you find
this information on VAweb?

(a) LINX

Navigation using Linux

1. What utility can you use to browse the files and directories on your system?
2. How can you access online help?
Printing
1. What option do you specify to 1pr to print a document on the printer named “koster”?

2. How can you find the name of your default printer? From a terminal emulation window, type

Logging Out

1. Why shouldn’t you just hit the power off button to shut down your systems? Select the best
answer.

Because Linux is a multiprocessor system and there might be other users on your system.

)
b) Because you might corrupt files and lose changes you made to your files.
) Because it will bring down the network.

)

Because it wears out the power switch.

2. Match up the command with what it does:

(a) CTRL-ALT-DEL (i) Exit out of your Linux desktop.
(b) CTRL-ALT-BACKSPACE (ii) Reboot the system.

Feedback (optional)

1. What other topics do you wish this course covered?

2. Other comments?
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2 Glossary
Here are a list of terms that are used in this course.

command line interface The shell, which allows you to type instructions and arguments that execute
a command. Access the command line interface by running a terminal emulator.

default The value that is used if no other value is specified. For example, print out will be printed on
your default printer if you do not specify the name of another printer.

desktop An interface with a window manager, supporting operations including drag-and-drop, launch-
ing applications by clicking on an icon, resizing of windows.

directory An area on a disk where the names and locations of files are stored. On the Macintosh,
directories are called folders.

email alias If you send email to an email alias, it will get forwarded to a person’s actual email address.
Typically email addresses are set up if someone wants to receive email sent to an email address
than does not include her username. People set up email aliases using nicknames or common
misspellings of their usernames, e.g., I set up nancy@valinux.com and nblackman@valinux.com
as email aliases for nblachman@valinux.com.

email auto-respond A program that responds to email received with a predefined message that typ-
ically includes the subject of the sender’s message. Turn on auto-responding using the program
vacation.

environment variable There are special variable, known as environment variables, that tell the shell
how to behave in certain circumstances. For instance, HOME is the name of your home directory.
The variable MAIL is set to the standard file where your email is kept. If the EDITOR variable is
set to the name of your favorite editor, some programs will start up that editor automatically.
Environment variables are typically specified in terms of only uppercase letters.

file A block of information stored on disk, tape, or other media. A file may contain text, a collection
of data, or a program.

fixed-width font A Font in which all the characters are the same width. Courier is an example of a
fixed-width font. Notice how an i is the same width as a w in Courier. But in a variable width
font, a w is wider than an 4.

gnu Gnu stands for Gnu is not Uniz. The GNU project predates Linux and was started by Richard
Stallman who has made significant contributions to Linux. Some people call Linux GNU Linux
to recognize GNU projects contributions to Linux.

graphical user interface A way of communicating with the computer by manipulating icons (pic-
tures) and windows with a mouse or pointing device. StarOffice and Gimp are programs that
have graphical user interfaces.

gui A graphical user interface.

home directory You are placed in your home directory when you log on to a Linux System. Typically
home directories are of the form /home/username. The symbol ~ is a shorthand notation for your
home directory. When you invoke the command cd with no arguments, you will change directories
to your home directory.

KDE The K Desktop Environment, which is the default desktop for VA Linux Systems workstations.
It is based on the Common Desktop Environment (CDE) standard from which Microsoft Windows
was also derived. It provides icons, a toolbar, and menus with applications.

KEdit A simple text editor available on KDE.
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kpilot A program available under KDE for sync’ing your Palm Pilot or your Handspring Visor with
your L‘inux system.

operating system A program that controls a computer and makes it possible for users to execute
commands and run programs and applications.

process An instance of a running program.

process-id Each process is assigned a number called its process-id. ;From a shell window, use the
command ps to see the processes you are running along with their process-id’s. You can send a
signal or kill a process using kill pid, where pid is the process’ id.

prompt A symbol used to indicate that the shell is ready to accept a command. A prompt might be
or terminate with $, %, or >. In these notes, my examples typically use $ as the prompt.

shell The shell is a command line interpreter that allows you to instruct the kernel (the core of Linux)
to perform services for you. Typically the shell is used to execute programs and applications.

signature file A file that is attached to the end of all your email messages. On Linux systems, the
signature file is typically stored in a file named .signature in a person’s home directory.

sync Synchronize. The application KPilot allows you to synchronize or make the files on your Pilot
or Visor identical to those on your Linux system. If you have updated a file on your Pilot, the
updated version will be uploaded to your Linux system.

Source A Slashdot!2 style newsletter containing VA Linux Systems news as well as discussions.

terminal emulator A program that emulators a terminal by providing a command line interface. A
terminal emulator on Linux is used to enter commands to the shell.

vi A visual text editor available on nearly all versions of Linux and Unix.

3 Related Links

Here are links you should check out.

https://vaweb.valinux.com — VA Linux Systems’ internal Web site.

https://vaweb.valinux.com/Administration — Employee information, i.e., links to information
that is useful to employees,

https://lists.valinux.com/lists/listinfo — Mailing lists.

https://vaweb.valinux.com/Training /EmployeeInfo/printers.html — Locations of printers,
faxes, and copiers,

https://vaweb.valinux.com/Training/html — An online tutorial on How to Create Web Pages
and Put them up on VAWeb.

https://vaweb.valinux.com/Training/desktop/desktop.pdf — These course notes in Acrobat
(pdf) format.

125]ashdot.com is a web site that has “news for nerds.” It is maintained by Andover.net, which was acquired by VA
Linux Systems in June of 2000.
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